Automation Engine

Products
# Contents

1. **Products Basics**................................................................................................................................. 3  
   1.1. The Products Concept.................................................................................................................. 3  
   1.2. Global Products and Job Products............................................................................................... 6  
   1.3. Products can have Multiple Parts............................................................................................... 7  

2. **Products Data Structure**.................................................................................................................. 9  
   2.1. Examples of Data Zone Depth.................................................................................................... 11  

3. **Products Views and Menu**.............................................................................................................. 15  
   3.1. The Products Gallery View......................................................................................................... 15  
   3.2. The Product(s) in a Job View...................................................................................................... 19  
   3.3. The Product Menu...................................................................................................................... 21  

4. **Product (Part) Properties**............................................................................................................... 23  
   4.1. Product Setup............................................................................................................................ 23  
   4.2. Product Part Setup..................................................................................................................... 25  

5. **Creating Products**........................................................................................................................... 27  
   5.1. Creating Products Manually....................................................................................................... 27  
   5.2. Uploading As a New Product...................................................................................................... 28  
   5.3. Creating Products Automatically............................................................................................... 28  
      5.3.1. Example Workflow 1: Building your Products Database from your Existing Data........... 29  
      5.3.2. Example Workflow 2: Adding New Incoming Designs as Products............................... 31  

6. **Linking Products to a Job**............................................................................................................... 34  

7. **Launching Tasks on Products**........................................................................................................ 35  

8. **Working with Products in Editors**................................................................................................ 36  

9. **Tasks specific for Products**........................................................................................................... 39  
   9.1. The Add to Products task........................................................................................................... 39  
   9.2. The Link Product to Job task...................................................................................................... 40  
   9.3. The Remove Product task.......................................................................................................... 41  
   9.4. The Manage Product Status task.............................................................................................. 42  
   9.5. The Wait for Product Status task............................................................................................... 43  
   9.6. The Check Product Parameters task.......................................................................................... 44  

10. **Publishing Products to WebCenter**............................................................................................ 46  

11. **Backing Up and Archiving Products**.......................................................................................... 47  

12. **Removing Products**...................................................................................................................... 48
1. Products Basics

1.1. The Products Concept

What is an Automation Engine Product?

An Automation Engine Product is a one-up graphics production item stored in the Automation Engine Products database. A Product represents a Stock Keeping Unit (SKU). A Product is what you Step&Repeat on a plate or press, possibly combined with other Products.

As explained in The Job Concept, a Job is a to do item for Automation Engine. A Job is not a thing, it is an activity with a specific goal. A Job is temporary, you delete it when the Job is done. A Product does represent a thing and is not temporary, you expect it to come back in other production (output) orders. For example, you could have 200 Jobs, 20,000 Products and 20,000,000 files.

In Types of Jobs, we also describe that a Product is the result of a "Prepress Job-Order", in which the goal is to get a design ready for production and customer approved. From that moment on, the Product can be used in many "Production Job-Orders", where the only task is to produce (output) it.

It is easier to integrate Automation Engine with a business system when both use the same concepts. It will be easier to translate the incoming orders into a prepress (data) context. It will also be easier to give feedback to that system about statuses in prepress.

The Main Principles when Working with Products

Working with Products typically means following this process:

• You first check your data structure. Working with Products requires that your Job data are split from your Product data. Learn more about in Products Data Structure on page 9.

• Then you build up your Products database. Learn more about how to automate this in Creating Products on page 27.

• Then you start linking Product(s) into your Jobs. This way, the Product data files are not inside the Job Folder. Product data are independent: today they can be linked to Job 123 and next time to Job 456. They can even be linked to several Jobs at the same time.

In Automation Engine, this temporary relation to a Job is a temporary link between items in the Product database and items in the Jobs database:
Here is an example how this looks in the Pilot: the Job 440123 links to 3 Products:

Note: You can work with Products without working with Jobs. However, in all classic print production environments Esko advises to use the Jobs concept.

Product File Formats

These file formats are supported as Automation Engine Products:
• PDF

**Note:** Non-Normalized PDFs cannot be checked for barcode parameters. Learn more in *The Check Product Parameters task* on page 44.

• ArtPro
• Adobe Illustrator (Esko DeskPack workflow).

**Note:** You will only see a product part thumbnail when the AI file was saved as PDF compatible.

It is possible to add other file types to the Products database, but it will become clear that Automation Engine does not offer (m)any valuable features for such files (no thumbnail, few tasks possible, provided parameters are irrelevant etc.).

**Who typically uses the Products tool?**

The Products tool benefits all customers that have product items coming back into production, all environments that do some form of re-runs. These sites usually are printers/converters.

If your business is to produce an item only once, then you may conclude it is not worth to add these files to the Products database. If you produce an item only once, you then probably end by removing the Job and storing its data somewhere as a backup, just in case you need it again for some unexpected reason.

**Benefits of working with Products**

• Data efficiency: no more needless copying or searching of data.
• A transparent data structure that supports the process logic of re-runs.
• A more user-friendly interface: thumbnails and colors indicating status.
• Automation Engine now speaks the same language as your business system, this enables a higher form of integration, leading to even more automation.

**What is the Products tool not?**

The goal of the Products tool is *not* to make Automation Engine a Digital Asset Management system (DAM).

These are some differences with a DAM:

• The Products database only stores one version. There is no automatic versioning tool.
• Searching for references is limited. You can see which Products are used in a Job and you can see in which Jobs a Product is used.
• File support: the Products tool is designed for one-up graphics production files, not for images or CAD or 3D or admin data.

**Note:** You can use WebCenter as a DAM for your graphics production data. WebCenter offers automatic versioning and supports all file formats. There are also standard available tasks to up- and download data from WebCenter to Automation Engine in case you need it (back) for production. Learn more in *Synchronizing Products with WebCenter*, a section of the dedicated chapter *Integrating with WebCenter*. 
Do I have to Install an Extra Database?

No. An installation of Automation Engine already provides the required database.

Note: Product attributes are stored in the same database as the one that is configured for Jobs (see Tools > Configure > Automation Engine Database > Jobs).

Automated management of Products (and Jobs) via Integration

The goal of using the Products tool is to work more efficient. It is therefore important that you automate the management of your Products. Creating them manually or changing their status manually would again reduce efficiency.

You can automate managing (Jobs and) Products by integrating Automation Engine with your order management system.

These should be your goals for such automation:

- All new Jobs and Products appear automatically.
- Jobs automatically link in their Products.
- Products statuses change automatically.
- Ideally, the business system makes a difference between Prepress and Production Jobs.
- Production Jobs should be fully automatic, the Product(s) they link to are already approved so the only limitation should lie in how far you can fully automate the Step&Repeat.

See Tasks on Products to learn about tasks you can use in a Products workflow. As usual, these tasks can also be triggered from an external system. Learn more in Integrating with External Systems.

1.2. Global Products and Job Products

A Global Product is the one we described earlier: its data is not inside a job folder, it is independent. Global Products can be linked into several jobs (even at the same time).

It is however possible to store the data of a product inside a job folder. We then call it a Job Product. It can only be used in that job. Some Prepress Service Providers (trade shops) or commercial printers, who don not normally produce re-runs, use this concept.

Like Tickets, the global version is visualized with a yellow icon and the job (local) version with a blue icon. See some examples in Products Views and Menu on page 15.

See this example of a Job Product, notice how the product file is located inside the job folder:
1.3. Products can have Multiple Parts

A Product can be a combination of multiple Product Parts. These parts then come together on press or later in finishing and so end up as 1 SKU in your warehouse.

Some examples:

- A bicycle helmet is sold in a plastic wrap that also contains a paper sheet with product information. The sheet was printed in 2 print runs: first the front in 2 colors (front.pdf) and then the back in 1 color (back.pdf). This front-back printing made these 2 Product Parts become 1 Product (after cutting). 1 Product is kept in the warehouse (1 SKU), 1 Product is ordered by your customer.

**Note:** There could be other Products that use the same front Part but a different back Part as their (language) variant.

- A booklet is glued to a label. These 2 Product Parts come together in finishing and so become 1 SKU, 1 Product to be ordered.
These are Not Multiple Parts of one Product:

At first glance, these 3 labels look like Parts of a same Product. This may look that way to the brewery, for whom the product is the beer bottle.

But, for the label printer, these are 3 different Products.

- They do not come together in printing or in finishing.
- In the warehouse, they are 3 separate SKUs.
- They can be ordered separately: your customer can for example order 6,000 front labels, 3,000 French back labels and 3,000 Spanish back labels.
2. Products Data Structure

**Important:** This page illustrates data structures to work with *Global* Products (where the product data is not inside a job folder).

### Splitting Product data from Job data

When jobs link to product (data) it is important that they do not share any folders. This data separation can be achieved in many ways.

Here are 2 examples:

- **On the left**, an example where the data split between jobs and products happens quite high in the container.
- **On the right**, an example where this data split is done per customer.

**Note:** Using customer names for folder has its disadvantages too. Customer tend to change names for example. Learn more about your options in *Good Practices regarding Job Folder Location*.

### Organization of Product data

Once your product data is split from the job data, you can freely decide how to structure that product data.

See these 2 examples:
• **On the left** all the product data is in 1 same folder FruitCo Products. This is usually not advised because it quickly leads to having too many files in a same folder (slow browsing, general system slowness etc.). And if you want to select a file related to a product file, you will again have to browse, even when they are in subfolders like Originals or Proofs.

If you create further subfolders that avoid having too many files in one folder, then this is a valid way to organize your data.

• **On the right** each product has its own folder. This is advised. When each product has its own folder, you can
  • use subfolders to store related files.
  • choose whether you store the actual product file in its root folder (as in above example) or in its own dedicated subfolder, for example named Production file.

⚠️ **Attention:** The more structure and consistency you have, the easier it will be for other systems to also benefit from this data structure. They can then rely on finding files in specific places and will also be able to provide you files in specific (sub)folders.

---

**Note:** When creating Product (Parts) via JDF, see *Products JDF setup* to learn about extra possibilities.

---

**The Product Data Zone (PDZ)**

A product has one or more **Product Parts** and each part refers to a specific product part file. So when we talk about the product data we more precisely mean the product part data. Learn more in *Product (Part) Properties* on page 23.

The place where the product part file and its related files are located is also referred to as the product part **Data Zone**. In the Pilot, when working with products, you sometimes want to launch tasks on files related to that product. For example: selecting its report file and launching the E-mail task. That is why it is advised to see more data in the Pilot than just the product part file.
The Depth of a Data Zone

The Data Zone is not just the folder where the product part file is located, it can be a larger zone. How large this zone is is decided by its **Depth**.

The reason to set this depth is to control how much data the Pilot users will see and have access to when selecting a product in the Pilot.

The depth of a product part data zone is decided when the product is created. It then takes the value as defined in **Tools > Configure > Products > Product Part Data Zone**. Learn more in [Configuring the Data Zone Depth](#).

Here are some examples:

### 2.1. Examples of Data Zone Depth

**Example 1: a Product Part with a Data Zone Depth of 1**

The product shown below was created with a data zone depth of 1. See how, when you select the product thumbnail, the **Data Zone** pane not only shows the folder Esko where the product part file is located in, but also 30001, which is 1 folder higher. If the depth was 0, you would only see the folder Esko and so have no direct access to other product's related files.

Another place where this depth is visible is in the properties of the product part. Notice how the definition of **File** in this case starts with (1) folder name:

---

**Note:** In this properties dialog, it is possible to manually change this depth. This might be useful when a wrong depth was used at product creation time. In above case you could for example remove Esko/ from the **File** definition and it to the **Data Zone** path.
Example 2: a Product Part with a Data Zone Depth of 0

As in the above example, the product has its own folder and subfolders. But here, the actual part file is not stored in a subfolder, but it is located in the root of that product folder. See how the PDF is in the folder 22004:

![Example 2: a Product Part with a Data Zone Depth of 0](image)

This indicates a Data Zone depth of 0. There is no need to, when you select the product, to see a folder higher than 22004.

**Note:** In the Data Zone pane, folders below the selected part are always visible.

In the product part setup, notice how in this case the definition of File only contains the name:

![Example 2: a Product Part with a Data Zone Depth of 0](image)

Example 3: another Product Part with a Data Zone Depth of 0

In this example many product part files share a same folder, they do not each have their own folder and subfolders. Here's how it looks in Container mode:

![Example 3: another Product Part with a Data Zone Depth of 0](image)

See below how, when the product thumbnail is selected, the Data Zone pane only shows the file's parent folder FruitCo Products. Also here, there is no need to see 'higher', the related files are in the folders below:

![Example 3: another Product Part with a Data Zone Depth of 0](image)
In the product part setup, the definition of **File** does not contain a folder name:

**Example 4: a Product with 2 Parts with a Data Zone Depth of 1**

**Note:** Multi-part products were introduced [here](#).

This example shows a product that has 2 parts. Each product part file is stored in its own folder but they share a common root folder.

See below how, when you select a part, the **Data Zone** pane also shows 11106, which is 1 level higher than the folder the part file is located in:

In the product part setup, the definition of **File** contains 1 folder name:
3. Products Views and Menu

**Note:** In the Files view you can not see if a file is a Product Part. Use the here described view modes to work with products:

3.1. The Products Gallery View

In Container mode, select the Products view to see
• the **Product Gallery**: a view on all or a filtered list of your Products. Choose the thumbnail view or the list view.

• the **Data Zone** pane (switch it on or off in the menu **Product**). This shows the data zone of the selected product. Learn more in **Products Data Structure** on page 9.

• the **Tasks** pane (switch it on or off in the menu **View**). This shows all tasks launched on any of the viewed products.

• the **Launch Favorites** pane (switch it on or off in the menu **View**). This shows your favorite tasks available for the file type of the selected product(s).

**Note:** A thumbnail mentions N/A when the thumbnail is not available. The reason for this can be:

• because the product is an "empty" product: in JDF workflows, it is possible to create a product part that has no link to a file yet.

• because the product part file is not a supported graphics file type (as we listed here).

**The Products List View**

The list view offers the same functionality but shows the **Product Gallery** in columns:

Go to **View > Select Columns in > Product Gallery...** to customize which columns you see.
Tip: You can also right-click on a column title and deselect that column there.

Note: You can choose different columns for product parts (when also viewing the Parts pane).

Working in the Gallery view

Tip: You can select multiple products by using Command-click (Mac) or CTRL-click (Windows) or by using SHIFT-click to select a series.

You can use the Products Gallery view to

• create a new product ( ). Learn more in Creating Products on page 27.

• get information about products:
  • indicates a Global Product,  a Job Product. Learn more here.
  • To see if a product is linked to one or more jobs, you need to open the product’s Properties. Learn more in Product (Part) Properties on page 23.
  • In thumbnail view, the color of the top bar indicates the status. Learn more about statuses and their colors in Product Properties. When a product has multiple parts that do not have the same status, this bar will be shown in grey. Learn more about multi-part products below.
  • In thumbnail view, a number in the top right corner indicates that the product has more than one product part. Learn more below.
  • In thumbnail view, the text fields describe the main product attributes. Use View > Select Thumbnail info in > Product Gallery... to customize the information that is shown there.
  • manually change product properties. Press or right-click the product(s) and choose Product Properties.... Learn more in Product (Part) Properties on page 23.
  • launch tasks on one or multiple products. Select the product(s), choose a favorite ticket or right-click and choose New Task or Launch with.

Note: A task that you launch on a product part that is linked to a job will run in the context of that job. This is important when you use job related SmartNames in the task’s ticket(s).

Note: If a product is linked to more than one job, the task will run in the context of the job that this product was most recently linked to. Learn more in Product Setup on page 23.
Viewing Multiple Parts

When you select a product that has more than 1 part, an extra pane opens that shows those parts. This happens automatically when you activated the function 'Show Parts' from the menu Products.

Tip: You can re-size this Parts pane, the Pilot will remember its size.

Note: In the Data Zone pane, the file(s) representing the selected product part(s) will be highlighted in grey (and vice versa).

Note: The name of the main product thumbnail is the name of the first product part (as defined in its properties). Learn more here.

Note: The thumbnail info of a product part can be different than for the main product thumbnail. Set this info in View > Select Thumbnail info in > Parts....

By seeing the separate parts, you have all the above mentioned functionality also available on product parts.

If however you want the functionality (a task or managing properties) to happen on all parts, then there is no need to view or select any parts. For example launching a task on the main product thumbnail will automatically launch this task on all parts.

Filtering and Searching

The filter and search tools enable to quickly make smart product selections. You can also save these filters as a Smart View.

You can search and filter products in the same way as you do with Jobs. Learn more in Job View Filters.

More Functionality in this View

A lot of functionality is offered when you right-click one or multiple products:

• Use New Task and Launch with... to launch a task or workflow on your selected product(s). Learn more in Launching a Workflow on a File.

• Use Open..., Open With and View... to open the product part file in a chosen application or in the Automation Engine Viewer.
• Use File Info... to see the metadata of the product part file.

• All other features are described in The Product Menu on page 21.

3.2. The Product(s) in a Job View

When in Last Used Job mode, the Products view shows which products are linked into that job.

When this job is a "prepress job", your goal will be to get that product approved and ready for output. When this job is a "production job", you will probably work on step & repeat (in an editor or via tasks) and/or output tasks. Learn more about these job types in Types of Jobs.

See this an example of a production job that needs to output 2 labels:

![Automation Engine Pilot (Job: "4002")](image)

Notice how

• the 2 products have a status ‘approved’, which is typical when you start outputting them.
• a Step & Repeat task was launched on the 2 products.
• the resulting pdfpla file was output in the job's subfolder "Step&Repeat".
• that pdfpla file was selected to launch the Prepare for Viewer task.

Using the Data Zone pane to see All Related Data

In job mode, the Data Zone pane always shows the job folder. When a product is selected, you will also see the product's data zone.

In this example, selecting the 'mango' product made the Data Zone pane also show folder '200108' and its subfolders:
Note: The data zone of a product is decided at its creation time. Learn more in *Products Data Structure* on page 9.

In job mode, the **Data Zone** pane offers access to all the data relevant for that job:

- When you want to access a file in the job folder, browse to it in the (blue) job folder.
- When you want to access a product part file, click on the product part thumbnail and choose your action from there.
- When you want to access another file in the product's data zone, select the product part thumbnail to visualize its data zone and then browse in those (yellow) product folder(s).

### Hiding the Files View

The fact that you can access all data using the **Data Zone** pane, means that there is no more need to see the **Files** view (when you work with products).

Also, when you use the **Products** view and then switch to another job, the **Files** view will again be shown. To avoid that you need to click on the **Products** view again, you can choose to hide the **Files** View.

To do this, right-click on the **Files** view and choose **Remove from Views Bar**.

**Tip:** To see the **Job Setup** while staying in the **Products** view, select the blue job folder icon and use the shortcut CTRL-ALT-J (Windows) or Command-Alt-J (Mac).
3.3. The Product Menu

**Tip:** Many of the features offered in the Product menu are also offered when you right-click on a selection that you made.

- **New Product...** allows you to browse to a file, create it as a product and link it to the job you are in. Learn more in *Creating Products Manually* on page 27.

- **Upload as Product...** does the same as above but also uploads the chosen file to its new product data zone. You can use this for example when the file is still on your local computer, on a CD/DVD drive or already in a Container but not yet in its proper product place. Learn more in *Uploading As a New Product* on page 28.

**Note:** These features are also available when you right-click on an empty piece of canvas in the Product Gallery.

- **Link Products....** Use this feature to manually link product(s) to the job you are in.

- **Product Properties...** opens the setup of the product and its parts. Learn more in *Product (Part) Properties* on page 23.

- **Go To File** shows you the product part file in the Files view of the Container mode.

- **Explore Folder...** opens a disk explorer view of the folder of the selected product part file.

- **Link to Job...** enables a quick way you to link a product(s) to a job from a list of most recent used jobs (or choose **Select Job...** to select any other). You will get a warning when the product is already linked to that job.

- **Unlink Product.** In Job mode, use this to remove the selected product(s) from that job. This does not delete any files.

- **Hide / Show Parts.** Learn more in *the Products Gallery View* about working with Products that have Parts.

- **Manage Product Filters....** If you saved filters in your Products view, manage them here and decide if you want to add them in the Views bar (as a Smart View).

- **Manage Statuses....** This is where you can add or modify custom product statuses. This list also contains Milestone names that were allowed to be used as product status. The way to add or modify them is the same as described in *Manage (Custom) Milestones.*
4. Product (Part) Properties

Product properties are the attributes that are stored in the Automation Engine Products database.

The concept is very similar to the Job Setup fields for Jobs. Most of the properties also become available as SmartNames, in a dedicated category Product Information. Learn more on how to use SmartNames here.

Note: The SmartNames view allows to specifically test product part SmartNames. Learn more in Also Show Product (Part) Parameter SmartNames.

The properties are divided in general product properties (Product Setup) and properties specific to each product part (Product Part Setup).

Note: The concept of multi-part products was introduced here.

You can also use the Product Properties dialog to manually Add or Remove Parts. You can use the arrow buttons to sort the parts. A product will get its name and thumbnail from the product part that is highest in this list.

4.1. Product Setup

General tab

- **Name**: For global products, the product name has to be unique. For job products, the name has to be unique within a job. For example there can be multiple job products with the
same product name as long as they exist in different jobs. Learn more about global and job products here.

- **Product ID**: This is the product identification code, often (only) a number. The same remark as mentioned above about uniqueness is also valid here. The maximum length of a product ID is 32 characters.

- **Customer Name**: Select the customer that this product belongs to.

- **Customer's Product Reference**: This is the name your customer uses for this product. It can be useful as a search filter or for example to mention on a report file for this customer.

- **Custom Fields**: You can define up to three custom fields to help you search the products database or to use them as SmartNames.

- **Description**: You can add a description (maximum 128 characters).

- **Order Material**:

  An Order Material is the material that your customer wants a Product to be printed on. It's the name of the material as your customer understands it and probably used when he was ordering the production job. This name is the name of that material as it is mentioned on the job order.

  **Note**: It is possible that you internally use another name for this material, but that is what we refer to as ' (real) print material'.

  You can select it from those available in the View Order Materials.

- **Status**: Choose the products status from the list. Learn about standard and custom statuses in The Product Menu on page 21.

  **Tip**: You can use the Wait for Product Status task to hold and continue a workflow based on this status.

### Jobs tab

This is where you see which job(s) that this product is currently linked to, and when that link was made.

**Attention**: If the product is linked to more than one job, a task that is launched on that product will run in the context of the job that this product part was most recently linked to.
**Ordered Copies** is an attribute that can be set when you use the *The Link Product to Job task* on page 40. This number is picked up in the **SmartLayout** function of Esko's Step & Repeat editor **Plato** (learn more in *Working with Products in Editors* on page 36). This number also becomes a SmartName that for example can add its value to a report file.

**Parameters tab**

You can here add custom parameters that also become available as SmartNames.

**Attention:** Mind that these parameters need to reflect what is specific for this product (range). Parameters that relate to how you *output* this product (Step&Repeat, press...) are probably more job related parameters and so belong in the job setup.

### 4.2. Product Part Setup

You can specify more and different properties for a product part because

- a part refers to a file. Some part properties relate to the file's location and its graphics characteristics.
- a product can have several parts with different properties (for example the front has the barcode and the back only has one ink).

Most properties also become available as SmartNames (in the category **Product Information**).

See this example of a product with 2 parts:

**General tab**

- **Data Zone:** This is the path to the folder containing the product part. This could also be a folder one or more levels higher. Learn more about the important concept **Data Zone** in *Products Data Structure* on page 9.

- **File:** This is the name of the file for that product part.
**Note:** If the parts file is in a subfolder within the parts data zone, you can include a folder name in this field: subfoldername/file. Learn more in *Products Data Structure* on page 9.

- **Name:** This is the name of the product part. This can be different than the file name.
- **Custom Fields:** You can add up to 3 custom fields.

**Barcode tab**

If the product part file has an (Esko) barcode, you can specify its properties here. The barcode can be checked and corrected using the *interaction with Esko editors* or by using the *Check Product Parameters* task. The details and usage is identical as with jobs: learn more in *the Job Setup Barcodes tab*.

**Status tab**

Each product part can have its own status. This is relevant when a product has multiple parts.

**Note:** A product will automatically get the status of its parts when there is only one part or when the status of all its parts is the same.

The set a status, pick it from the list or use the *The Manage Product Status task* on page 42 task. If the status you choose has a **Nickname**, than that is the name you will see. Learn more about creating statuses in *The Product Menu* on page 21.

You see when and by whom the status of this product part was last changed. An extra note can also help clarify why the status was changed.

**Tip:** When the change was done by the *The Manage Product Status task* on page 42 task, the user name includes the name of the server.

**Parameters tab**

You can set custom parameters per product part. Their SmartName version shows up in the category **Product Part Parameters** and their name starts with `[ppp.]`.

**Inks tab**

The inks in the product part file can be checked and corrected by the *interaction with Esko editors* or by using the *Check Product Parameters* task. Details and usage is identical as with jobs, learn more in *the Job Setup Inks tab*.

**Note:** JDF workflows that create product (parts) can also specify such ink properties.
5. Creating Products

Products can be created

- manually, using the Pilot
  - by making a file a product part file
  - by uploading a file to a new place and then making that file a product part file.

- automatically
  - by using the Add To Products. The task then defines the product properties based on the file's URL or metadata or out of some XML file(s) etc.
  
  - by direct JDF/JMF commands. This technique communicates directly to the server software. For more information on JDF contact Esko Solution Services or find some basic answers in the chapter Integrating with External Systems.

Note: You can also use above tools to modify products (except the upload method).

Note: Removing products is described in this separate page.

5.1. Creating Products Manually

Note: Learn about the difference between global and job products here.

Creating a Global Product

Follow these steps to manually create a new product:

1. In the Pilot, go to Container mode and Products view and click on . Alternatively, go to Product > New Product... or right-click on an empty part of the canvas in the Product Gallery pane and choose New Product....

2. The dialog first asks you to select the file that you want to add as product part file. Make your selection and click OK to continue.

   Important: When you select multiple files, the next steps will create them as parts of a same product.

   Important: If you select a file that is located in an (active) job folder, you will automatically create a job product.

3. Now define the product's properties, both of the product and of the product part(s). Learn more in Product (Part) Properties on page 23.

   Tip: At this point, you can use the Add button to add extra product parts.

4. Click OK to confirm and create the product. The new product appears in the product gallery.
Creating a Job Product

To create a job product, you can use the same steps as above but you start in Last Used Job mode (you are in a job and you select a file located somewhere in that job folder).

5.2. Uploading As a New Product

Upload as Product... does the same as creating a new product but also uploads the selected file to its new product data zone.

You can use this for example when the file is still on your local computer, on a CD/DVD drive or already in a Container but not yet in its correct product place.

Much like Creating Products Manually, follow these steps to upload one or multiple file(s) as a new product (parts):

1. In Container or Last used Job mode, go to the menu Product > Upload as Product... or right-click on an empty part of the canvas in the Product Gallery pane and choose Upload as Product....
2. Select the file(s) and fill in their properties (same steps as when Creating Products Manually on page 27).
3. In the product part setup, there is now one extra field where you have to define the Destination of the file. Choose the Use the Smart Product Location as set in Configure or browse to where you want to store the product part.

The Smart Product Location is a tool that can define the location and name of the product part based on a product parameter or on the default location for that customer. Learn more in Smart Product Location.

Note: The Smart Product Location can be checked by clicking on Show Product Location.

4. Confirm with OK.

5.3. Creating Products Automatically

You can create products automatically by using the The Add to Products task on page 39.

You can launch this task

- as a user in the Pilot, after selecting an input file. This is advised when you use a task ticket in which SmartNames already fill in many properties automatically.
5.3.1.  Example Workflow 1: Building your Products Database from your Existing Data

When you start to work with the products tool, you may already have a lot of data that you want to add to your products database. With this existing data, your goal is to launch workflows that create many dozens or hundreds of products in one go.

**Attention:** Based on what you learned in *Products Data Structure*, you can decide to first re-arrange your data structure or to keep the data in their existing folders before you start creating your products.

**Tip:** It is good practice to first test this import on a part of your data, for example limited to one of your customers. We advise to also test your output workflows with some of that first set of products. You might learn details that you want to change before importing all your other products.

See this example where all the 200* folders contain one product part file in their root folder:

![Example Folders](image)

This is the workflow we will use to automate creating these products:
We first use a smart way to select only the part file we need. We then add it as a product. We then set the status.

These are important steps and settings in this workflow:

1. First manually select all the 200* folders and then launch or open your workflow.
2. The Data splitter (default settings) will split that group of folders and will so launch the Select File step on every separate folder.
3. In Select File, use these settings:

   - File Type: in this example the type we want is a normalized PDF.
   - In Select other Files, we select all those that are in the URL of what this step received as input: that (single) 200...- folder.
   - Do not Look in subfolders to avoid selecting the other PDFs or any report files.

4. In the Add to Products task, make sure to indicate the customer. We know the customer because we make a manual selection under the product folders of a specific customer.

   Tip: When you do not set the customer via a SmartName, this workflow ticket becomes customer specific. In such cases we advise to add that customer name to the name of your workflow ticket.

5. We propose to already set a status. When these data were produced earlier, you can for example set their status to ‘Approved’.

   Tip: When you are testing these workflows, make sure to check the Updating options in the Add to Products task.
5.3.2. Example Workflow 2: Adding New Incoming Designs as Products

When Should a New Design become a Product?

The concept of products allows to add them to the database very early. As soon as you have a representation, a new design, you can add this file as a product part.

You can use the product status to indicate what stage this product is in, for example New or Preflight OK or Waiting for Approval etc.

Changing the Product Part File During Prepress Stages

You can also change the product part file during a workflow. For example you first use the design file as the product part file but once you import or normalize or start editing you then move that original design file to a subfolder original and update the product part with the more recent (normalized) PDF file.

Note: To update a product you use the same Add to Products task but use specific settings in its Updating tab.

Creating a Product in a Job Context or Not

It is your choice to add the product while you are in a job context (in Last Used Job mode) or not (in Container mode).

As mentioned in Types of Jobs, when you do not work in a job context, it will be difficult to give feedback to your business system. However, many such systems do not give you a job-order number to do prepress work on new designs. Many of them only send you job numbers for ‘production jobs’ in which you output already approved products.

In that case, you still have a choice to create your own ‘prepress jobs’. A reason to do that is consistency, because then everything that your users do in prepress (with Automation Engine) happens in a job context.

Tip: But how do you name those self-created prepress jobs? You could base their name on the name of the product they are supposed to create. For example if you know you are preparing a new product that should be named 7890, then you could do this work in a job named Preparing_7890.

Avoid Changing a Product Name or ID: Get it Right from the Start

It is very important to get the product name and ID as soon as possible. You do not want to create a product and later change its name or ID. If this name is not sync with what the business system expects then there will be no or little integration possible. For example if you send the business system an early JPEG of the new design, it will need to have the correct name: the name of the item that this system expects.

In an ideal situation, your business system sends you a prepress job and in there mentions the name and ID of the product that it expects you to create.
In all other cases, to get this correct product name or ID, you will probably need to get this information from people working with the business system. It is in that admin department that this number was created. In the business process, those colleagues made the decision that you should prepare and output a new design or variant, so they will have a record of that item number (and name).

**Example Workflow**

Your new designs can come in via many different ways. An important tool to help automate creating them as a product are **Access Points**. An Access Point can detect a new incoming design and immediately launch a workflow that moves the file to the right folder for the product part and then adds it to the product database.

See this example:

- **A Folder Access Point** detects new designs coming in from the customer FruitCo.

  ![Folder Access Point Diagram]

  - This access point launches this workflow:

  ![Workflow Diagram]

  1. The found data is moved away from the access point folder to an 'arrival hall' for new designs for this customer:
**Important:** We use this intermediate place because we first want to check what the correct name and ID for this product will be.

2. The **Checkpoint** task asks a user to check with the admin department what the correct name and ID needs to be. When needed, the user manually changes the name of that design file.

3. The next **Move** task is now able to move the design to a new own product folder. The folder is decided by using SmartNames, based on the customer name and on the first 6 characters of the designs name.

4. Now that we have the file in the right place and with the right name, we create the product.

5. A preflight is executed on the file.

6. The status we set depends on the preflight result.

**Note:** You can of course extend this workflow with steps like editing and proofing. The goal of this ‘prepress job’ is to have an approved product item. An other job should then serve to output this product, possibly together with others.

**Note:** There are countless variations of how new designs can be processed. To create smart ways of automating their import to the products database, we advise to study all the possible tools mentioned in *Creating Products Automatically* on page 28.
6. Linking Products to a Job

A global product can be linked to one or multiple jobs. A job product can only be linked to one job.

You can link a product to a job

- manually, using the Pilot, in Products view,
  - in Container mode, by right-clicking one or multiple products, choosing Link to Job and selecting the job from the list of recently used jobs (or by using the dedicated menu item).
  - in Last used Job mode, by right-clicking in the Products panel, choosing Link Products... and selecting the one(s) you want (or by using the dedicated menu item).
  - in Last used Job mode, in the Data Zone panel, by selecting a file in the job (sub)folder and choosing the menu item Product > New Product.... This will create a job product and automatically link it to this job.

- automatically,
  - by using the The Link Product to Job task on page 40.
  - by using JDF/JMF commands. This technique communicates directly to the server software. For more information on JDF contact Esko Solution Services or find some basic answers in the chapter Integrating with External Systems.

Which Job(s) is this Product Linked To?

You can see the job(s) that a product is linked to

- in the product's properties. Learn more in Product Setup.
- in the list view. Learn more in Products Views and Menu on page 15.

Which Product(s) does this Job Link to?

You can only see which products a job links to by opening the job in Last Used Job mode.
7. Launching Tasks on Products

Launching tasks on products is very similar to launching tasks on files.

Here is some information specific to launching tasks on products:

- As with files, you can right-click on products and launch tasks from there. You can also launch Favorites.

- Launching a task on a product will launch it on all its product parts. If you want to launch a task on a specific part, use Show Parts to see the Parts panel and make your specific selection there.

- In Last used Job mode, in Products view, when you select one or more products and launch a task, it will run in the context of that job. The SmartNames will relate to that job.

- In Container mode,
  - tasks launched on products check if those products are linked to a job and will run in the context of that job. See an example where two products were selected and the ReportMaker task was launched:

- when a product is linked to multiple jobs, the task will run in the context of the job that the product was last linked to. Learn more in the Product Setup on page 23.

- In a workflow, you can use the Select File task to select all the product parts of the job (context) that that workflow is running in. The next workflow step is then launched on those product parts.
8. Working with Products in Editors

Editors that have been configured to be a client of your Automation Engine server, will show extra tools that help you work with products.

Easy Access to Open Products in Editors

Esko editors like ArtPro, PackEdge and Plato that communicate with an Automation Engine server, offer an easy way to open product part files.

In their **Open** dialog, extra **Job** and **Product** lists help avoid a lot of browsing:

- You can select a job first and then the products linked in that job appear in the list of products:

  ![Job and Product lists](image)

- You can press **Search...** to open a dedicated **Select Job** or **Select Product** dialog.
- You can click on the drop-down arrow to pick one from the memory of last used jobs or products.
- When you open a product that has multiple parts, an extra dialog will open to let you choose which part you want to open.

**Tip:** When you are editing a product and you want to update it with your changes, then you best use **Save** and not **Save as**. Saving as another name and/or in another folder will not change the product part's URL.

Editors Checking a Product's Barcode and Ink Parameters

As mentioned in the chapter on **Jobs**, Esko editors check if the file's barcode and ink settings match those that were defined in the file's job setup (in **Job Ink parameters** and **Job Barcode parameters**).

The same principle and tools are valid when your editor opens a product part file that has properties for barcode and/or inks.

**Note:** When both the file's product part and the file's job have such parameters defined, then the product part parameters are checked.

**Note:** When an editor is checking product parameters, the dialogs use the same wording: they also mention "Check **Job** Parameters" when they check **product** parameters.

And, as with job parameters, there is also a dedicated task to check or correct such product parameters. Learn more in the **Check Product Parameters task**.
In Esko Plato: Fast Ways to Load Products onto a Layout

Esko’s Step & Repeat editor Plato offers extra tools that also avoid searching and browsing when you put stations on the layout.

For this to work, Plato first needs to be aware in which job you are working. This is done in the Layout Setup dialog:

- When you create a Manual Layout, the dialog Place Station offers the same job and products lists as in the Open dialog, as shown above.

- When you create a new grid based layout, your right-click to add a station now also offers to add the product parts (that are linked in that job):

- When you create a SmartLayout, you can choose to Load All Products... that are linked into that job. Customers who often make layouts with many different files will quickly see the benefit of this function:

In Esko Plato: Using the Product Parameter "Ordered Copies"
When you load a product part in SmartLayout, Plato also checks the Product Setup parameter Ordered Copies and automatically fills it in in the SmartLayout dialog.

An example: This product is linked into 3 jobs but for job 440123 there are 7,500 Ordered Copies:

When Plato works in the context of job 440123, and when you use that product in your SmartLayout, that number of ordered copies will be filled in automatically:

Learn more about Plato [here](#).
9. Tasks specific for Products

Note: We here list the tasks. There are also workflow controls that are specific to Products. Those are documented here, in the chapter Workflows.

9.1. The Add to Products task

Attention: This task requires you to be familiar with the manual setup of Products.

You can use this task to create a product (part) or to add or modify parameters of a product (part). You cannot delete product (part) parameters using this task. Learn more below on how to update fields.

The setup fields can be filled with SmartNames, typed in values or values chosen from a list.

Select item to set up: There are different tab sheets for product and for product part setup. Every product has at least one product part, so both are important.

Setting Up the Product

• General: You here define the main product properties. This tab is similar to the General tab when you manually define a Product Setup. Learn more about each field in Product Setup on page 23.

• Parameters: You can here define custom product parameters. This tab is identical to the Parameters tab in the Product Setup. Learn more about each field in Product Setup on page 23.
• **Updating**: When a product with the same **Product ID** or **Product Name** already exists, this task will update that product. Define the rules here.

![Automation Engine Image](image)

- **Update**: If you want the existing product to be updated with the info from the task.
- **Do not update**: If you do not want the existing parameters to be updated.
- **Update and provide a warning**.
- **Do not update and provide an error**.

**Link Global Product to the current Job**: If you enable this the product in the task will be linked to the current job context.

- **Create Customer automatically when it does not exist yet**. Indicate if you want this.

**Note**: Mind that a customer exists when the **Customer ID** already exists.

### Setting Up the Product Part

The settings for the product part are very similar to the ones for the product, that we explained above.

For the part, there are extra settings for the part’s **File**:

- **Update**: If you want to update the product part with your task input file.
- **Do not update**: When the product part should not be updated with your task input file.
- **Update and provide a warning**.

### 9.2. The Link Product to Job task

The **Link Product to Job** task allows to link one or multiple products to a job.

It also allows to specify the **Ordered Copies**: this is the amount of product items that need to be produced in that job order.
Select Job

The job to link to can be indicated via its Name or via the combination of OrderID and SubOrderID. You can select a specific job from the list but typically you will enter a SmartName here.

Note: When the job does not exist, the task generates an error.

Note: When the input file belongs to a product that is already linked to the specified job, the task does nothing. This also means that the Ordered Copies specified in the task is then not set in the product properties.

Ordered Copies

Enter the amount manually or use a SmartName. Learn more in Product Setup and in using the ordered copies parameter in Esko Plato.

About the Task Input File

- When the input file is a product part of an existing Global Product, the product is linked to the specified job and the ordered copies is set for that job (if the product was not yet linked to the specified job).
- When the input file is a product part of an existing Job Product, the task generates an error.
- When the input file is not yet a product part, the task generates an error.

9.3. The Remove Product task

Concept

This task removes a product from the products database. It is typically used in a workflow where it is preceded by the Select Product workflow control.

As described in The Products Concept on page 3, products should be removed from the database when they are no longer relevant to your production. This decision is often taken by the business system. You can set up an automated workflow where that business system triggers a workflow that removes the product(s) that the business system described in an XML file. Learn more about triggering tasks from a business system in Integrating with External Systems.

Attention: This task does not remove only parts from a product. This means that also when the input of this task is a product part, it will be the product that this part belongs to that will be removed. This means that this task cannot be used to only remove part(s) of a product.
General Behavior

- When the input file is a product with multiple parts, then that product and all its parts are removed from the database (and optionally from the file system, learn more below).
- When the input file is a product part, the product that that part belongs to is removed.
- When the input file is a product part which is shared by multiple products, then all those products and their parts are removed. There will be no warning if that is the case.
- When multiple inputs are specified, the task removes all corresponding products and all of their parts.
- When an input product name or ID matches both with (one or more) Job Products and also with (one or more) Global Products, then
  - when this task runs in the context of a job, then only the matching job product of that job will be removed.
  - when this task does not run in a that job context, all the matching global product(s) will be removed.
- When the input file is not a product (part), then, in a workflow context, the output of the task is the input file and is put on the Error pin.

Options

- **Remove file.** This will also remove the file of that product part.
- **Remove complete data zone.** This will also remove the complete data zone of the selected product. Learn more about data zones in *Products Data Structure* on page 9.

  **Warning:** A data zone can overlap with the data zone of other products! There will not be a warning or error in such a case!

  **Attention:** We advise to only choose to remove the complete data zone when you are sure you have a backup of those data.

Learn more about removing products in *Removing Products* on page 48.

### 9.4. The Manage Product Status task

The **Manage Product Status** task allows to set the status of a product.
You can add an extra comment.

**Tip:** Adding a comment is most useful when the status change was a user's decision. For example a comment that mentions that the customer couldn't approve via E-mail or web due to network problems and so exceptionally called you to confirm that he approves the file.

This task is often used to automatically set the product status during a workflow. See some examples in *Creating Products Automatically* on page 28.

### 9.5. The Wait for Product Status task

The **Wait for Product Status** task allows to hold a workflow until (all) the input product part(s) reach the status specified in the ticket.

This task will wait until **all** Product Parts reach that status.

Learn more about product (part) status in *The Product Menu* on page 21 and *Product (Part) Properties* on page 23.

**Note:** This task ends in error
- when none of the input files are product parts.
- when one of the input product parts is deleted from the products database while the task is waiting.

This task is typically used to prevent output before the product part(s) are approved. See this example workflow:

Notice how the input of the **Wait for Product Status** task is defined by the **Select File** task that has a specific option to select all the product parts in the job:
9.6. The Check Product Parameters task

**Note:** The concept and tools explained here are very similar to those in the *The Check Job Parameters Task*.

The **Check Product Parameters** task allows to make sure that the barcode and/or inks of the task’s input file match the properties specified in its *Product Part Setup*. You can use the task just to check the file or you can use it to automatically correct the file.

**Note:** The input file must be a *Product Part* file.

**Important:** When no output file name or folder were specified in the ticket, the *Auto Correct* actions will overwrite the input file.

For **Barcode** settings, you can select:
• **Auto Correct** when you want to correct the file according to what is specified in its *Product Part Setup*.

For example, your normalized PDF includes an Esko barcode of type EAN-13 and code 123456789012, and your product part specifies EAN-13 and code 5449000050205, then this task will automatically correct the barcode number in the PDF to 5449000050205.

• **Stop with Error** when you want the task to stop with an error if the barcode in the *Product Part Setup* does not fully match the barcode in the file.

Note: This task only checks barcodes created in Esko PackEdge or by using Esko's barcode plug-in for Adobe Illustrator (DeskPack). If the task does not find such a barcode, the task will end in a warning.

Note: You cannot use this task to check and auto correct barcodes in normalized PDFs generated by *ArtPro*.

For **Inks**, you can select:

• **Auto Correct**: For each ink in the input file, the task checks if the characteristics of the ink match the settings in product part parameters. If they don't match the file is corrected.

• **Auto Correct (Strict Checking)**: Same as above but also generates an error if the file's list of inks and the order of inks is not exactly as defined in the product part parameters.

• **Stop with Error**: This is a strict check on the list of inks, their order and their characteristics.
10. Publishing Products to WebCenter

You can use the *Publish On WebCenter* task to publish files from within an Automation Engine container to a WebCenter project.

When you launch that task on an Automation Engine product,

- the product part file will be stored as a project document
- the product part file will also be stored as a document in the **Bill Of Material** of that WebCenter project. The product (part) properties can be stored as WebCenter document attributes.

**Note:** The reverse is not possible: it is not possible to push WebCenter document attributes to Automation Engine product parameters.

Learn more about this in *Publishing Products to WebCenter*, a page in the dedicated chapter on **Integrating with WebCenter**.
11. Backing Up and Archiving Products

Backing Up Product Data

As explained in *The Products Concept* on page 3, data belonging to products are important data that you want to keep online for a long time. This is why we advise to schedule a regular backup of your product data. This can be done with many specialized (non-Esko) backup applications.

Additionally, we advise to use the *database backup tools of Automation Engine*. The products database contains the properties of all your products. Remember that you can not restore selections of this database, restoring is done on the complete database. And remember that the products database is not a separate database but a database table in the jobs database.

**Note:** Some customers also use the Pilot to back up the product part files. You can select all or groups of products in your products gallery and launch tasks that can copy that data to a near-line disk or off-line to some device (CD/DVD). You can launch the Create PAF / JPG / XML (*LinkEdge*) task (on normalized PDFs) or the *Copy* task or you can create workflows that copy the whole product part data zone. If you accidentally lost product data, it will then be easy to recuperate a selection of that copied data.

Archiving Product Data

As explained in *The Products Concept* on page 3, a product should stay in your database as long as a job-order can come in that needs (to output) it. Ideally, the business system informs you when its users have decided that a product item is ‘end-of-life’.

Some customers keep some outdated products in the database to use them as basis for new designs. When you do this, mind that exceptionally large databases may cause your system to slow down.

**Tip:** When you do keep outdated products in the database, make sure to give them a status that is easy to recognize, for example end-of-life or do not output.

Another reason to remove old products is to avoid the risk of using them again in production.

**Tip:** You can reduce that risk by using a workflow that checks the status before outputting. See an example in *The Wait for Product Status task* on page 43.

**Important:** The *Archive Job* task archives and restores job folders and job products. Global product files are not stored inside job folders and will not be archived by this task.

In summary, there is no specific task or procedure to archive products. We advise to stick to these general rules:

- Make regular backups of all your product data and database.
- Remove products from the database when you can.
- Use the product status to help indicate if a product can still be used for output.
12. Removing Products

What Happens when you Remove a Product?

When you remove a product, the product and all its parts are removed from the product database. The product part files on disk are not removed.

Removing a Global Product does not leave a memory of the product (part) parameters. When you make the file a product (part) again, it will not propose you any previous settings.

This is different when the product was a Job Product that was removed together with the job. When you remove a job it always stores a memory of all its settings in a subfolder and this is also done for settings of any job products. When you then use that ex-jobfolder to (re-)create a job, the old product(s) are re-created in this job as job products and will have all their product (part) settings again.

When do you Remove a Product?

As mentioned in The Products Concept and in Backing Up and Archiving Products, (global) products are created to be used for a long term.

It makes sense to remove a product when you are sure it will never need to be produced (output) again. In other words, when there are no more benefits of having it in a database: when you don't link it into jobs anymore or you don't use its SmartNames any more.

Removing a Product when in Container mode

In the Product Gallery, select the product(s) and press Delete or use the right-click or menu function Product > Remove Product. A dialog will ask you to confirm.

By default, you can not remove products when they are still linked to a job. However, you can force this removal by using the option to also remove those job-links at the moment you remove the product(s). This is the option Also remove from linked jobs or Also remove linked products from all linked jobs.

Removing a Product when in Job mode

When you are in a job's Products view and you select a linked product, pressing Delete serves to Unlink the product from that job. However, the resulting dialog offers an option to Also remove the product from the products database:
When you are asking to remove a product that is still linked to other jobs, you will see this warning:

![Warning Message]

If you want to remove products that are linked to multiple jobs, you need to do this in Container mode (in the Product Gallery).